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About this course
Objectives of the course
Upon completion of this course you will be able to use the new and 
enhanced tools of the Mechanical Design Workbenches in V5R19 Release.

Targeted audience
Mechanical Designers

Prerequisites
Students attending this course should have knowledge of 
CATIA Mechanical Design V5R18

1 day
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Sketcher Updates
You will learn about the following new and enhanced functionalities of the CATIA 
Sketcher workbench.

What's New in CATIA Sketcher Workbench
New command: Upgrade
New command: Explode
Enhancement in Positioning As Result With Link Sketches
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What's New in CATIA Sketcher Workbench

The list of enhanced functionalities are given below:

New Functionalities:

Upgrading the Features: 
The new ‘Upgrade’ contextual command is available on the Sketch features which allow you 
to access the ‘Best so far’ level of the software compatible with sketch features data.

Exploding Sketch: 
The new ‘Explode’ contextual command allows you to convert ‘As Result With Link’ pasted 
sketch (non-editable Sketch), into an editable sketch.

Enhanced Functionality:

Positioning As Result With Link sketches: 
This capability allows you to position the sketch obtained by ‘As Result With Link’ paste 
option. You can position the sketch by specifying the directions and position of origin in the 
Sketch Positioning dialog box. 
You can also restore the link in position with the copied feature using the new option 
‘Positioned as reference’ which is available in the Type field.
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New Command: Upgrade
You will learn how to Upgrade the sketch features.

V5R19V5R19
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About the New Upgrade Command

The new Upgrade command will modify all the versioning data in order to put in place 
the latest version compatible with the data contained in the sketch. It is available 
through the contextual menu on the sketch feature. 

Upgrade capability on the sketch features allows:
End-users to take advantage of all the 
versioned corrections between the original 
level and current level, without recreating the 
feature.
End-users to use the last optimized 
algorithms (performance improvements) and 
also access the new capabilities/behaviors.
Administrators to upgrade the old template 
data.

This capability is also applicable for part features.

V5R19V5R19

It is necessary to update the feature and its subsequent features after Upgrade command.
The orientation of the element may be modified after Upgrade. 
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How to Upgrade a Sketch

You can upgrade a sketch feature by using the contextual command Upgrade. 

Upgrade operation will modify all the 
versioning information of Sketch.1 in order 
to put in place the ‘Best so far’ version that 
is compatible with the existing Sketch data. 

Select Sketch.1 object > Upgrade from 
the contextual menu of Sketch.1.
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New Command: Explode
You will learn how to Explode the Sketch feature.

V5R19V5R19
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Why to Explode

A sketch obtained by copying and pasting with As Result With Link option is a copy 
of its reference sketch feature. 

Exploding the sketch removes the Copy feature from the specification tree and 
converts every wireframe geometry associated to the datum feature to a standard 2D 
geometry feature.

Copy/Paste 
As Result with Link

Isolate

Original Sketch

Associativity is maintained 
between the reference geometry 
and the copy.
The copied sketch is non-editable.

Explode…

Sketch feature is non-
associative, and the isolated 
sketch is non-editable.

V5R19V5R19 You cannot edit sketch 
obtained by copying and 
pasting with As Result With 
Link option till V5R18. 
The new ‘Explode’ command 
helps you to avoid this 
problem.

After this ‘Explode’ operation, 
there is no more associativity
between the ‘Exploded’ Sketch 
and its previous reference 
Sketch. The exploded sketch 
is editable.
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More About Explode 

The copied sketch does not take into account the following data of its reference 
sketch while exploding:

Construction, Axis geometries, and Use-edges (projections, intersections etc)
Constraints and Dimensions
Geometry on Output feature

Generic naming which identifies each geometry will not be kept 
when performing the explode operation.
The order of the geometry in the specification tree after explode 
operation is different from the order in the reference sketch.

Copy/Paste 
As Result with Link

Explode…

You can see Axis geometry, 
Constraints and Output features 
are not retrieved after explode.

After explode, it is necessary 
to update the sketch feature. 
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How to Explode a Sketch

You can explode the sketch feature by using the contextual command Explode... 

Select Sketch.2 object > Explode…
from the contextual menu of the 
Sketch.2.
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Enhancement in Positioning As Result With Link 
Sketches
You will learn how to position As Result With Link Sketches.
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About Enhancement in Positioning As Result With Link Sketches

You can position the sketch (obtained by copying and pasting) using the ‘As Result With Link’
option. You will be able to use the ‘Sketch Positioning’ dialog box to position ‘As Result With 
Link’ pasted sketches. 

A new option ‘Positioned as reference’ is available for positioning the sketch. This enhancement will 
allow you to restore the positional link with the copied feature. When you select the Positioned as 
reference type, all the other fields are disabled and set to the default value.

V5R19V5R19

V5R19V5R19
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Let us learn how to use position As Result With Link Sketch to create louvers.

How to Position ‘As Result With Link Sketch’ (1/2)

1 Copy the 
Louver_Sketch and 
paste it with ‘As 
Result With Link’
option. 2 To change the position of the copied 

sketch, select Change Sketch Support 
from the contextual menu.

3 Use the Positioned Type to 
position the sketch on the 
adjacent face.
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Let us learn how to use position As Result With Link Sketch to create louvers.

How to Position ‘As Result With Link Sketch’ (2/2)

4 Use the copied positioned 
sketch to create a Louver.

5 Change the dimensions of the original 
Louver_Sketch. Change the width of 
Louver.

6 Update the Sketch. 

Observation:
The  copied Louver_Sketch
gets updated as per original 
Louver_Sketch. 
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Part Design Updates
You will learn about the following new and enhanced functionalities of the CATIA Part 
Design workbench:

What's New in CATIA Part Design Workbench
Enhancement in the Edge Fillet
Recap Exercise: Edge Fillet with Blend Corner
Enhancement in the Hole Definition
Other Enhancements
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What's New in CATIA Part Design Workbench

The list of enhanced functionalities in CATIA Part Design V5R19 is given below:

Enhancement in the Edge Fillet: 
This contextual menu is added to create and manage the ‘blend corner' capability of 
the edge fillet. Now it is easier to edit the edge fillet containing blend corners.

Enhancement in the Hole Definition:
This highlight adds capability to select the anchor point of the tapered hole. Two 
check boxes are provided to select the anchor point of the hole.

Upgrading the Part Design Features:
This new contextual command is available on the part design features which allow you 
to access the current release level of CATIA and its data.

Displaying and Editing Parameters in the specification tree :
This enhancement provides a display of features parameters under its node in the 
tree. This is very convenient to quickly edit the values without opening the dialog box.
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Enhancement in the Edge Fillet
You will learn about the new options available for managing the blend corners in the Edge 
Fillet. 

V5R19V5R19
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About Enhancement in the Edge Fillet (1/3)

V5R19V5R19

While applying the fillets to the sharp edges, the corners resulting from the operation are not 
always satisfactory. The goal of this enhancement is to easily create and edit the ‘blend corners' 
of the edge fillet.

A contextual menu has been added in the blend corner field to create, edit and manage the blend 
corners of the edge fillet.

In V5R18, when you change the edges to be filleted, then the blend corners must also be 
redefined, even though they are not impacted by the modifications performed in the edge fillet. 
There is no way to keep the definition of the existing blend corners.

Blend Corner
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About Enhancement in the Edge Fillet (2/3)

The enhancement provides the following options in the Blend corner's contextual menu to create 
and edit an edge fillet containing at least one blend corner :

Select Vertex

Reframe On: It reframes the model at the selected corner.
Create by edges: It automatically adds the corresponding blend corner with default 
setback distance. The selected and propagated edges are added to the list of objects. This 
option does not remove the existing blend corners.

Create by vertex: It automatically adds the corresponding blend corner with default 
setback distance. The concurrent edges of the selected vertex are added to the list of 
object(s) to fillet if these edges are new ones or if they are not part of the propagations. 
This option is available even if some corners are already defined.



Student Notes:

Mechanical Design V5R19 Update
����������	��

Copyright DASSAULT SYSTEMES 23

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

About Enhancement in the Edge Fillet (3/3)

Edit: This option displays a list of editable setback values. However, an error message is 
displayed if you edit multiple blend corners.

Remove.
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How to Create a Blend Corner Using Create by Edges

You will perform the following steps to create a Blend Corner using Create by edges 
option

1 Click on the Edge Fillet icon. 

2 Select the edges to be filleted.  

Right-click the Blend corner(s) field and 
select Create by edges.

3

4
Enter the Setback distance as 
15mm  and click OK to create 
the  Edge fillet.
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How to Create a Blend Corner Using Create by Vertex

You will perform the following steps to create a Blend Corner using Create by vertex 
option

1 Click on the Edge Fillet icon. 

3
Select the vertex. 
(The concurrent edges will be 
automatically selected.) 

Right-click the Blend corner(s) field and 
select Create by vertex.

2

4
Enter the Setback distance 
and click OK to create the  
Edge fillet.



Student Notes:

Mechanical Design V5R19 Update
����������	��

Copyright DASSAULT SYSTEMES 26

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

How to Edit a Blend Corner in the Edge Fillet

You will perform the following steps to edit a Blend Corner in the edge fillet

1 Double-Click the Edge Fillet in 
the specification tree. 

3 Enter the Setback distance values 
and click OK.

Right-click the Corner.1 in the Blend 
corner(s) field and select Edit.

2

4
Click OK to create the Edge 
fillet.
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Edge Fillet with Blend Corner
Recap Exercise

10 min

Edge Fillet with Blend Corner
Blend Corner with Setback distance 
Edge fillet with different setback 
distance values 

In this exercise you will create:
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Do It Yourself (1/3)

Select the five edges of the solid.

Part used: UMD19_BlendCorner_5edges_Start.CATPart

Right-click the Blend corner field and select 
‘Create by edges’.
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Do It Yourself (2/3)

Right-Click the newly created Corner.9 in the Blend 
corner field and select Edit…

Enter the different values of Setback distance and 
click OK to create the fillet.
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Do It Yourself (3/3)

Right-Click the Shell.1 and reorder it to the end of 
the specification tree. 

Observation:
You can see that now it is easier to 
edit the fillets with blend corners.End Part: UMD19_BlendCorner_5edges_End.CATPart
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Enhancement in the Hole Definition
You will learn about the anchor point in the tapered hole.

V5R19V5R19
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About Enhancement in the Hole Definition (1/2)

You can specify the diameter value for the ‘Tapered’ hole at the level of the selected 
face. You can specify the diameter value for the hole's upper or lower end by selecting 
Top or Bottom in the Anchor Point selection.

V5R19V5R19

If the bottom diameter leads to an invalid 
profile, the main diameter is kept and the hole is 
computed like a simple hole.

Upper end is selected as 
Anchor point

Taper 
value

Diameter 
value

Lower end is selected as 
Anchor point

Taper 
value

Diameter 
value

1

2

3
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About Enhancement in the Hole Definition (2/2)

In the example discussed in the previous slide, the design intent is to have holes as 
per the following drawing. This design intent is now quickly achieved in V5R19 using 
the new enhancement of Anchor point setting.

Anchor Point: Bottom

1

1

Anchor Point: Top2

2
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Do It Yourself

Create the hole 
Diameter = 4.5mm; Depth = Up to next
Tapered type with 12º angle
Anchor point as ‘Top’

Create the hole
Diameter = 4.5mm; Depth = Up to next
Tapered type with 25º angle
Anchor point as ‘Bottom’

Part used: UMD19_Hole_Definition.CATPart

Hole 2

Hole 1

1

2
3

4
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Other Enhancements

Upgrading the Part Design Features:
This new ‘Upgrade’ contextual command 
available in the part design features allows 
you to access the current release level of 
CATIA and its data.
It enables you to take advantage of all the 
versioned corrections between the original 
level and the current level of CATIA, without 
recreating the feature.

Displaying and Editing Parameters in the 
specification tree:

It displays the parameters under features 
node in the tree. This is very convenient to 
quickly edit the values without opening the 
dialog box.
It helps you to see which parameters are 
bound by knowledge and check the 
parameter value.
It improves your productivity when 
modifying an input value for a Part Design 
feature.
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Assembly Design Updates
You will learn about the following new and enhanced functionalities of the CATIA 
Product Design workbench:

What's New in CATIA Assembly Design Workbench
New Command: Associativity
New Command: Add to Associated Part
Recap Exercise: Associativity and Add to Associated Part
Enhancement in the Constraint Creation
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What’s New in CATIA Assembly Design Workbench

The list of enhanced functionalities in CATIA Assembly Design V5R19 is given below.

New Command: Associativity
This capability allows you to modify the CATPart geometry in the assembly context (without 
modifying the reference) to create a new CATPart. The new part is instantiated in the assembly. 
It contains a copy of the chosen geometry, which is obtained by the Copy/Paste As Result With 
Link operation. If required, you can also select customized components of the active assembly.

New command: Add to Associated Part 
This capability allows you to create a body obtained by Copy As Result With Link of a chosen 
geometry. The created body will be added to the selected CATPart’s PartBody.

Redundancy check during constraint creation:
This enhancement provides you with an option in CATIA Settings to enable/disable the 
redundancy check performed during constraint creation.
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New Command: Associativity
You will learn how to create and modify an associated CATPart of the CATProduct
without modifying the reference CATParts.

V5R19V5R19

V5R19V5R19
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What is an Associativity

The ‘Associativity’command allows you to modify a CATPart geometry in the assembly context 
(without modifying the CATPart reference). A new instantiated  CATPart is created using the 
Copy / Paste As Result With Link option, and an ‘Associated Part’ node containing the copied 
geometries is added under the active assembly. The copied geometries are associative to their 
reference CATParts.

PartBodies of Rings are instantiated 
with default PartBody color.
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More About Associativity (1/2)

You can use the ‘Associativity’ command for CATPart with multiple instances, by which a 
separate PartBody for each instance will be created. However these PartBodies will have only 
one CATPart as reference. If you make any change in the reference CATPart, it will be reflected 
in all the instances. 

You can restore the deleted ‘Associated Part’ node by updating the assembly.

While creating an Associated Part, you can select the following features 
of the geometry to be associated:

Part Body
Other bodies
All Geometrical Sets and Ordered Geometrical Sets
All axis systems
External view

You can use Customize option to precisely select the bodies to 
copy for each selected part.

For creating an Associated Part using ‘Associativity’, the instances and PartBodies must 
be in the active state.
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More About Associativity (2/2)

When you select the 'Restrict external selection with link to published elements' check box in 
Tools > Options, it automatically checks the 'Only published Features' checkbox and 
deactivates it in the Assembly Part Association dialog box.

‘Allow publication in Associated Part’ check box, if checked then the publication from the 
reference part will be copied to the associated part.



Student Notes:

Mechanical Design V5R19 Update
����������	��

Copyright DASSAULT SYSTEMES 42

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

How to Create an Associative Part from a CATProduct (1/2)

Double-click 
the sub-
assembly to 
activate it. 

Select the 
Associativity 
icon.

Select the 
options as 
per the 
dialog box 
and click 
OK.

A new Associated part 
will be created with the 
publications under the 
product node.

Open the Associated Part in 
the New window and fill the 
open end of each ring with 
Pad.

1

2

34

5
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How to Create an Associative Part from a CATProduct (2/2)

Modify the 
associated part 
by providing a 
fillet of 0.5mm 
radius to the 
inner corners 
and save it.

Double-click the 
Body from which 
the Associated part 
is to be removed. 
Remove the 
Associated 
PartBody from the 
Main Body. Make 
sure that Keep link 
with selected object 
option is active.

Similarly remove other 
associated PartBodies
from the Main Body.

Now after hiding the Associated 
Part and Rings, you will see that 
the grooves are created on the 
Piston.

6 7

8

9



Student Notes:

Mechanical Design V5R19 Update
����������	��

Copyright DASSAULT SYSTEMES 44

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

New Command: Add to Associated Part 
You will learn how to create and modify an associative CATPart without modifying its 
reference CATPart.

V5R19V5R19
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About ‘Add to Associated Part’

In the case of existing source parts, if the bodies/geometries of these parts already exist in 
the associated part, then you cannot add them to it again.

In this example using ‘Add to Associated 
Part’, geometries from Ring.1 are copied 
and added to the Piston.

You can modify the CATPart geometry in the assembly context using the ‘Add Associated 
Part’ command. You can add geometries from existing/new source parts in the product into 
the associated Part. The geometries will be associative with their reference CATParts. 
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How to Add an Associated Part (1/2)

Click the 
‘Add to 
Associated 
Part’ icon.

Double-click 
Piston_Pin.1 Body 
created under the 
Associated Part.

Select the Associated Part 
(The part in which other part  
is to be added) and the Part to 
be associated (which is added 
to the part) and select other 
options.

Now edit the associated Piston_Pin
Body by filling the hole in it.

1 2

3

4
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How to Add an Associated Part (2/2)

Now Double-click 
Connecting_Rod_Machined
and remove ‘Body.2 from 
Piston_Pin.1’ from it.

Hide the Piston Pin and 
you will see hole as per 
size of the Piston_Pin.

Update the 
assembly.

After updating 
you will see  
that the hole 
gets modified 
as per the Pin 
radius.

Open Piston_Pin
in new window 
and change the 
radius of ring from 
12.5mm to 13mm

5

67

8 9



Student Notes:

Mechanical Design V5R19 Update
����������	��

Copyright DASSAULT SYSTEMES 48

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
T

E
M

E
S

Associativity and Add to Associated Part
Recap Exercise

20 min

In this step you will create pockets on the Cellphone cover for placement of the Buttons using 
Associativity and Add to Associated Part command. This enables you to use buttons for pocket 
creation. You can maintain associativity between the Buttons and their locations without modifying 
them in the assembly.

Create the Associativity feature.
Add a CATPart to the Associated Part.

By the end of this exercise you will be able to
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Do It Yourself (1/4)

Part used: Cellphone_Assembly.CATProduct

Create the pockets in the mobile cover using the Blue Buttons present in the assembly

Using the assembly feature Add to Associated Part add CallEnd_Button and Call_Button
into the Cellphone_cover.
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Do It Yourself (2/4)

Remove the copied bodies from the Cellphone_Cover using the Boolean 
operation. Make sure that ‘Keep link with selected object’ option is checked.
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Do It Yourself (3/4)

Using the assembly feature Associativity, create three PartBodies of the 
Middle_Button under the Middle_Button Product node.
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Do It Yourself (4/4)

Remove these three PartBodies of Middle_Button from the Cellphone_Cover using 
the Boolean operation. Make sure that ‘Keep link with selected object’ option is 
checked. Repeat the same procedure for creating pockets of Left_Button and 
Right_Button.

End Part: Cellphone_Assembly_Completed.CATProduct
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Enhancement in the Constraint Creation
You will learn about new option Redundancy Constraint Check in constraint creation.

V5R19V5R19
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About Redundancy Constraint Check

In CATIA while you create the constraints the Redundancy constraint check is performed. 
This check affects directly the amount of time required for constraint creation. This 
happens particularly when you work with huge assemblies with hundreds of parts loaded 
together with many constraints. 

V5R19V5R19

Now with this new enhancement a setting has been provided at Tools > Options > 
Mechanical Design > Assembly Design > Constraints with which you can enable or disable 
the redundancy check while the constraints are created. Hence You can avoid the 
“redundancy checks” .
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Generative Shape Design Updates
You will learn about the following enhanced functionalities in the Generative Shape 
Design workbench:

What's New in Generative Shape Design Workbench
Enhancement in the Sweep
Enhancement in Points and Planes Repetition
Enhancement in the Planes Between
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What's New in CATIA Generative Shape Design Workbench

The list of enhanced functionalities is given below:

Enhancement in the Sweep
This highlight will enable you to allow canonical surface detection in sweeps like linear, 
circular or conical.

Enhancement in the Points and Planes Repetition
This highlight will enable you to select any type of point (e.g. point created on the curve 
with datum mode, intersect, extremum, projection, and the points which are not lying on 
the curve) as a reference point to create multiple points in the Points and Planes 
repetition command.
A Preview button is added in the dialog box to view the result before exiting the dialog 
box.

Enhancement in the Planes Between
A Preview button is added in the dialog box to view the result before exiting the dialog 
box.
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Enhancement in the Sweep
You will learn about the canonical portion detection in the sweep command.

V5R19V5R19
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About Canonical Portion Detection in Sweep (1/2)

A check button called ‘Canonical portion detection’
is added in the sweep dialog box (for the Line, 
Circle and Conic Sweep). 
This highlight will provide you with an option where 
you can allow the canonical surface detection of 
sweeps like linear, circular, or conical.

Canonical surface: It is a surface, which is defined in 
a simplest form, without loosing its original geometry. 
Sphere and cylinder are examples of canonical 
surface.
In V5R18, for ‘Explicit Sweep’, canonical surface 
detection is always ON, by default.
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If you create a sweep surface without selecting the Canonical portion detection option, 
then you will not be able to use the surface as a sketch support.

About Canonical Portion Detection in Sweep (2/2)

Now you will see the use of this option. 

If you check the Canonical portion detection option, you can use the surface as a 
sketch support.

Sweep surface created without selecting the option You can not select this surface as sketch support

Surface created using the option
You can select this surface as sketch support
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Do It Yourself (1/2)

Data to be used: Canonical_Portion_Detection_Sweep. CATPart

In this exercise, you will detect whether the surface is 
canonical or not.

It shows that the surface is not canonical.

Click the Axis Icon.
Select Sweep.1 to compute whether it is a  canonical 
surface or not.
Get an error of invalid element.
Cancel the command.

Sweep.1
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Do It Yourself (2/2)

In this exercise, you will use the enhancement.

It shows that the surface is canonical.

Edit the Sweep.1and turn on (or check) the 
‘Canonical portion detection’ button.
Create the axis by selecting the sweep surface.

Sweep.1
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Enhancement in the Points and Planes Repetition

You will learn about the enhancement in the Points and Planes Repetition command.

V5R19V5R19

V5R19V5R19
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About Enhancement in the Points and Planes Repetition (1/2)

New input fields ‘First Point’ and ‘Curve’ with contextual menu are 
added in the Points and Planes Repetition command, to specify the 
first reference point and the support curve on which multiple points 
will be created.

This highlight adds capability of selecting any type of point 
(e.g. point created on the curve with datum mode, intersect, 
extremum, projection, and the points which are not lying on the 
curve) as a reference point to create multiple points in the Points 
and Planes repetition command. 

In R18 you are able to select points created on the curve using the 
command Point with type ‘On Curve’ (but not other types of points). 

In R19, you can select all these 
types of points as a First point.
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About Enhancement in the Points and Planes Repetition (2/2)

Contextual menu is provided for the first input in the ‘First Point’ field, second input in the 
‘Curve’ field, and third input in the ‘Second Point’ field. Contextually created inputs will be 
aggregated under the first point which was created using this functionality.

A Preview button is added in the dialog 
box to view the result before exiting the 
dialog box.
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Do It Yourself (1/3)

Data to be used: UMD_R19_Points_Planes_repetition.CATPart

Click the Points and Planes Repetition icon.
Select Datumpoint.1 as the First Point and Curve.1 as 
Curve.
Set the instance value as 10 and see the result.
Repeat the above steps for different points.

You will create points on the curve using different types of 
reference points.

Points created on the curve
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Do It Yourself (2/3)

Use the data from the previous slide.
Click the Points and Planes Repetition icon.
Right-click the ‘First Point’ field. Choose Create Point 
from the contextual menu and create a first reference 
point using the Coordinates type.
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Do It Yourself (3/3)

Right-click on the ‘Curve’ field. Choose Create Spline from the 
contextual menu and create Spline.1 using the contextually created 
point in the previous step, Point.1 and DatumPoint.1.
Set the instance value as 10 and see the result.
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Enhancement in the Planes Between

The highlight provides you the capability to preview the output for the Planes Between 
command, before clicking the OK button.

This highlight enables you to confirm the number of planes to be created. If the output 
obtained is contrary to the expectations, you can change the inputs and then create the 
plane again. 

The Preview button is required for confirming the 
expected output and to have ease in performing the 
modifications.
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Drafting Updates
You will learn about the following new and enhanced functionalities of the CATIA 
Drafting workbench:

What's New in CATIA Drafting Workbench
New Command: Advanced Bill of Material
Enhancement in Rigid position Links
Enhancement in Broken Constraints Visualization
Enhancement in 3D Clipping
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What’s New in CATIA Drafting Workbench

The list of enhanced functionalities is given below.

New Command: Advanced Bill of Material (BOM):
This highlight enhances capability and productivity of the BOM by enabling you to perform 
variety of tasks such as customization of BOM, editing of BOM table etc.

Enhancements in Positional Links:
With this highlight it is now possible to create a rigid positional link. The rigid character of the 
positional link makes the move relatively to the reference impossible. 

Enhancement in Constraints:
This highlight enables you to see the broken constraints as well as normal (non broken) 
constraints. You will be able to visualize the broken constraints and be able to quickly edit those 
thus enhancing the productivity.

Enhancement in Clipping:
In addition to the existing methods of defining the 3D clipping object (manipulators being moved 
manually, spinners, and edit boxes), you will be able to select a point or a line (in 2D and 3D 
view) or a planar face / plane / edge in 3D view in order to define the position of the current 
manipulator.
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New Command: Advanced Bill of Material
You will learn how to insert the Advanced Bill of Material

V5R19V5R19
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Why Advanced Bill of Material

You can use the Advanced Bill of Material to modify the contents of the Bill of Material and also 
add additional contents in it such as Material, Definition, Source, Weight etc.

Bill of material is a critical part of the design and manufacture of any product. 

A Bill of material can define products as they are designed, manufactured, ordered, or maintained. 
A Bill of Material (BOM) lists all the items that go into a finished good or subassembly. The Bill of 
material is the base part of any production process. If you don't have a well defined list of 
ingredients you can't make the part. Of course in the real world a BOM is much more than a listing 
of the parts which make up the items we manufacture.

The Advanced BOM provides you the following advantages:

You can insert the BOM in a particular view or sheet as separate sheets are created
You can insert BOM without opening the assembly file.
You can modify the contents of the table using the properties of the table.
You can customize the BOM table.
You can invert or split rows at the time of BOM insertion. 
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More About Advanced Bill of Material (1/3)

A new command, Advanced Bill of Material is added. The Bill of Material command is also 
available in the same menu. You can opt for any one of the two commands. 

V5R19V5R19

In the Bill of Material creation dialog box you have two options:
Invert: Select this option if you want the table to be read 
from bottom to top (i.e. column headers will be at the 
bottom and numbering order will be reversed ).
Split: Select this option to split the BOM table into several 
tables.

After clicking on the icon you 
will see the Table split dialog 
box.
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More About Advanced Bill of Material (2/3)

For splitting the table there are some options provided such as,
Maximum number of rows: You can specify the maximum number of rows that each 
table should contain after splitting, irrespective of the total number of rows.
Maximum height: You can specify the maximum height of each table.
Horizontally: You can provide option of splitting horizontally.
Vertically: You can split the table vertically.
Duplicate Title: You can also repeat the Title in each table.

This is what we can get with Advanced Bill of 
Material using the enhanced functionalities.

You can split the BOM table after generating it. 
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You can insert the Bill of Material to the single part also.

You can edit the BOM table by right-clicking on the table and select Table.X object > Edit BOM 
from the contextual menu.

You can manually add columns. The modifications made in them are updated and saved.

The Bill of Material update status is not taken into account in the drawing update status. So 
even if the Bill of Material is not up-to-date, the Update icon is not activated. You must use force 
update command to update the Bill of Material. 

More About Advanced Bill of Material (3/3)
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Customizing the Bill of Material (1/2)

You can customize the Bill of Material suitable to your requirement of detailing, designing, and 
manufacturing.

b

c
d

Right-click the BOM 
table and select 
Properties from the 
contextual menu.

V5R19V5R19

a. Type: The administrator can change the settings in Tools > Standards > Drafting > [standard 
name] > Styles > Bill of Material. This option is unavailable by default. 

b. No Value Label: You can set a default label when no value is set in the appropriate property 
field. The default label is “-”.

c. No Material Label: You can set a default label that will be displayed when no material is 
specified for the part.

d. Item Number Label Type: You can label the components in an assembly alphabetically or 
numerically by selecting the Integer or the Letters option.

a

In the Properties dialog box, the BOM Format tab has  the following options:
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Customizing the Bill of Material (2/2)

You can add different Titles for one property suitable to your Bill of Material.

Right-click BOM table and 
select Properties from the 
contextual menu.

In the Properties dialog box, Reported 
Properties tab has the following 
options:

a. New: To add an extra column 
to the table.

b. Delete: To delete the unwanted 
columns from the table.

a

fe

d

b

c

V5R19V5R19

c. Move up and Move down arrows: To rearrange the order of columns from left to right in 
the table.

d. Drop down list: You can add new properties to the column from the drop down list.
e. Title: You can edit the Title of the added property.
f. Column width: You can specify the width of the column that is added.
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Editing the Bill of Material

You can edit the BOM table which has been inserted in the assembly Drawing.

Effect of removing the component Drill_Diam_8 from the assembly.

Effect of adding the new part “Part 1” to the assembly.

Effect of replacing the Drill_Diam 8 by Drill_Diam 9.
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Do It Yourself (1/2)

Part used: Drill_Machine.CATDrawing

Select Insert > Bill of Material > Advanced Bill of Material.
Select the options for inverting and splitting the BOM table.
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Do It Yourself (2/2)

Set the values in the Table split dialog box.
Click OK.

Select the view or product and click the location of placement of the BOM table.
Finally you will get the format of the required table.

End Part: Drill_Machine_BOM.CATDrawing
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Enhancement in Rigid Positional Link for 
Annotations
You will learn how to create the rigid position link for Annotations.

V5R19V5R19
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About the Enhancement in Rigid position Link for Annotations

A new option called Rigid is added under the Positional Link command. If this option is 
selected the relative position between the annotation and its reference cannot be changed.

You can fix annotations such as Text, Roughness Symbol, Balloon, Datum Feature, Datum 
Target, Welding Symbol, Table, and Geometrical Tolerances with respect to their 
references.

V5R19V5R19 If required, you can later change the rigid 
character of a positional link by clearing the 
check mark.
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More About Rigid Position Link for Annotations

You can have control on the creation of a rigid positional link by default. The setting 
Create rigid positional link in Tools > Options > Mechanical Design > Drafting > 
Annotation and Dress-up is provided.
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Enhancement in Visualization of Broken 
Constraints
You will learn about the enhancement in visualization of broken constraints

V5R19V5R19

CATIA V5R18

After modification 
and update

After modification in the reference profile 
used to sketch, the broken constraints are 
highlighted with a red triangle.
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About the Enhancement in Broken Constraints Visualization

Now the broken constraints are visualized at the same time as the normal (non-broken) 
constraints. You will be able to see them and to select them.

Previously the only way to access and delete the broken constraints was to use the Edit/Search 
command. You had to find out all constraints and retrieve those which were not valid.
You can interactively access the broken constraints, see them, and delete them if needed.

Types of Constraints: 
There are six types of constraints that can be broken such as Parallelism, Perpendicularity, 
Coincidence, Concentricity, Tangency, and Symmetry. 
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More About the Broken Constraints Visualization

For visualizing the broken constraints you need to check the following settings to confirm 
that the broken (or non-broken) constraints are not hidden.

Go to Menu Tools > Options > Mechanical Design > Drafting > Geometry and check the 
Display constraints option.
Check in the Visualization toolbar and confirm that the Show Constraints option is active.

The colors of the broken constraints are those of the inconsistent elements. This can be 
changed in Tools > Options > Drafting > Geometry.
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Do It Yourself (1/2)

Part used: Brk_Constraints.CATDrawing

Open the drawing and visualize the constraints.
Open the Part linked to the drawing.
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Do It Yourself (2/2)

Change the sketch profile of the pocket and save it. 
Open and update the Drawing.
Broken constraints will be visualized.
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Enhancement of 3D Clipping Box
You will learn how to use 3D Clipping box to generate a view.

V5R19V5R19

V5R19V5R19
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About the Enhancement of 3D Clipping Box

In addition to the existing methods of defining the 3D clipping object (manipulators being 
moved manually, spinners and edit boxes), you will be able to select a point or a line in 2D 
and 3D view or a planar face / plane / edge in 3D in order to define the position of the 
current manipulator.

Point, Line (they must be generatively created) in 2D.
Point, Line, Edge, Planar face, Plane in 3D, FTA Plane in 3D and the geometry outside 
the 3D clipping box.

The following geometries can be selected if the plane containing the geometry is parallel to 
the current manipulator plane:

Some of the important things regarding 3D Clipping

The 3D Clipping object is not available for the following views:
Section cut views, Aligned section views, Unfolded views, 
Views from 3D, Advanced front view with DMU box, CGR, 
Raster and Approximate views.
Any geometry inside the Clipping Object dialog box cannot be 
selected.
2D view selection is not supported.
3D clipping object is not associated with the 3D element.
Only one clipping object can be added per view.
Cut in section view has no effect on a 3D Clipping.
After the 3D clipping is created it can be modified or removed 
using the options provided in the Contextual menu.
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How to Add/Modify 3D Clipping

Select the view 
to create 3D 
clipping and 
click Add 3D 
Clipping icon.

Select the face from 
the 3D product/part.

Double-click 
the 
manipulator 
to set it as 
current.

Manipulator 
plane will be 
aligned to the 
face.

This new enhancement enables you to generate more precise and accurate 3D clippings. 
It also improves the productivity by reducing the time for manipulation of the plane.

Repeat this 
procedure for other 
planes and click 
Create. Clipping 
view will be 
generated.

1 2

3

5

4
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Do It Yourself (1/5)

Part used: Vice_Assembly.CATDrawing

Open Vice_Assembly.CATDrawing. 
Open ViceAssembly.CATProduct linked to the drawing.
Select the Front View and then from the menu select Add 3D Clipping.
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Do It Yourself (2/5)
From the Clipping Mode select the Clipping Box.
Double-click green manipulator to set it as current.
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Do It Yourself (3/5)
Select the edge from the Drawing, the Clipping Box face will be aligned to the face 
corresponding to the selected edge.
Double-click the other green manipulator to set it as current.
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Do It Yourself (4/5)
Select the point from the product.
Similarly, for top and opposite side manipulators select blue line and blue plane as shown.
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Do It Yourself (5/5)
Drag the other manipulators and position the box.
Click Create.
Clipping view will be created.

Part used: Vice_Assembly_Completed.CATDrawing
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Sum up

In this course you have seen the major enhancements in the CATIA Mechanical Design 
solutions domain for V5R19.

Part Design Enhancements 

Product Design Enhancements

Wireframe and Surface Design Enhancements

Drafting Enhancements


